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GarageBand 2.0 is part of Apple’s iLife ’05 suite of programs. Need music for your iMovie HD
video or your iPhoto slideshow? Want to enhance your musical performances with effects and
pre-made musical snippets? GarageBand allows you to create your own musical masterpieces
by editing and mixing your instrumental and vocal performances.
Note: This tutorial assumes that you are familiar with the concepts introduced in
“GarageBand 2.0 – Getting Started.” Take a look at this introduction to the program
to become familiar with the GarageBand interface and the basics of song creation.
Objectives
By the end of this tutorial, you will be able to:
• record your own performances using an external musical instrument or GarageBand’s onscreen keyboards.
• make changes to your recording, including adjusting the timing of individual notes, cutting
and pasting sections, and enhancing tuning.
• mix tracks to achieve optimal sound quality.
• export your final creation to iTunes for use in other programs or external storage.
Helpful Terms
Balance – changes the amount of sound coming out of each speaker. Default setting (middle of
the dial) is equal sound from each speaker.
BPM – beats per minute. 120 bpm is equivalent to two beats per second. GarageBand
measures tempo in bpm.
Loop – a pre-made musical snippet that you can add to your creations. Entire songs can be
made using only loops!
Real Instrument – Tracks using these instruments are actual audio recordings. They can be cut,
copied, and pasted, but the actual notes cannot be edited.
Software Instrument – Tracks using these instruments are computer-generated. The actual notes
of the track can be changed.
Track – GarageBand songs are made up of many tracks; each line in the main window is a
different track.
For many more helpful definitions, see the Glossary in GarageBand Help.
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I. Recording
GarageBand is, above all, designed to be a home recording studio. If you have a musical
instrument that can be connected to the computer, GarageBand lets you record your
performance. You can also use a microphone to record instrumental or vocal performances. If
you don’t have a computer-compatible instrument or a microphone, GarageBand provides onscreen “keyboards” that can be used to create your own tracks.
On-Screen Keyboards
GarageBand offers two types of on-screen keyboards. Both can be used to record tracks. These
are not advanced enough to allow you to perform a complicated piano piece, but they do allow
you to record simple melody and harmony lines.
The first type of keyboard often appears automatically when you begin a new song. Simply click
on the keys to play. To bring up the keyboard at any time, select Keyboard in the Window menu.

The smaller keyboard inset in the top of the window allows you to choose what octave to use.
The blue section highlights the area of the keyboard that you are currently using. The small grey
arrows on either side of the larger keyboard also allow you to move up and down an octave. The
numbers on the keyboard also denote octaves.
Note to pianists (and others familiar with a piano keyboard): The GarageBand onscreen keyboards have more octaves than a standard piano, going both higher and
lower. C0 is the lowest C that would normally be on a piano keyboard. C3
corresponds to middle C.
Another way to record melody and harmony lines is with Musical Typing. This keyboard allows
you to make more adjustments as you play. To bring up this type of keyboard, select Musical
Typing in the Window menu.

Again, the small inset keyboard can be used to change the octave, along with the Z and X keys.
Unfortunately, you can only play in one octave at a time.
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Advanced adjustments: Press the tab key to turn sustain on/off. The 1 and 2 keys adjust the
pitch up or down as long as you hold the key. Press the 4-8 keys to adjust modulation as you
would with a mod wheel; press 3 to turn modulation off. C and V adjust the velocity (i.e. how hard
you “press” the keys).
External Instruments
If your musical instrument provides a way to hook it into a computer (usually through USB or MIDI
connections), you can use it in GarageBand. Also, if you have an audio interface or mixer
connected to the computer, you can connect your instrument to it. You can record these
performances as Real or Software Instrument tracks.
You can also connect a microphone to the computer and use it to capture performances on
instruments that are not computer compatible. These will appear as Real Instrument tracks.
Once you’ve connected your instrument or microphone to the computer, be sure to adjust the
input settings. Open System Preferences, select Sound, and go to the Input tab. Select the
appropriate device in the sound input list, and you can now adjust its input volume.

Choosing a GarageBand Instrument
Before we start recording, we need to select an instrument for our new track. Create a new track
by clicking on the New Track button (the plus sign in the bottom left corner).
Now, choose whether you’d like to make a recording as a Real or Software Instrument.
Remember, Real Instrument tracks are audio recordings, so you’ll need a microphone to create
these.
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In the Real Instrument tab, you can adjust the sound input channel and the input volume of your
instrument. Don’t forget to check these properties in System Preferences – Sound too!
Click on the triangle to the left of Details (bottom left corner) to view more options. Select an
instrument from the main window and use these details to adjust the track’s effects. You will also
be able to adjust these later if needed.

To create a Software Instrument track, click on the Software Instrument tab in the New Track
window.
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Like the Real Instrument window, you can select from a variety of pre-made instruments or create
your own. To edit or add effects, click on Details.
Remember, Software Instruments are not audio recordings; the computer records the actions on
the instruments as it would keystrokes on a keyboard. When you playback the track,
GarageBand processes the actions it has recorded. Software Instrument recordings have more
editing options available than Real Instrument tracks.
Recording Options
GarageBand offers several features to make recording easier in the Control menu.

The first item, Metronome, turns on/off a metronome that plays on the beat as you record. The
metronome counts off beats with a quiet ticking sound. This can ensure that your performance’s
tempo matches the rest of the song. The metronome will not be heard when you playback your
recording.
The second item, Count In, counts a full measure with quiet ticks before the recording begins.
This way, you have a feel for the tempo of your performance when you begin playing. This also
gives you time to prepare to play after pressing the Record button. I highly recommend turning
on Count In when you record!
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The last item, Show Instrument Tuner, allows you to tune your instrument before recording. This
is most helpful when recording Real Instrument tracks.
Recording a Track
Now, we’re finally ready to begin recording.
First, make sure that the track you want to record in is selected. Next, make sure that you are
completely ready to begin playing; recording will begin as soon as the button is pressed (unless
you have turned on Count In, which I again strongly encourage).
Select the measure where you want the recording to begin by moving the progress marker in the
ruler at the top of the window. Now, just click on the record button and begin playing at the
appropriate measure/beat.

GarageBand automatically selects the Play button when you click on Record, so if you have
already added other tracks to your song, these will play along with you as you record. If you do
not want to hear the other tracks, click on the Solo button in the track information column (see
Mixing – Track Controls). You can also turn off specific tracks by using the Mute button.
To stop recording, click on the Record button again. Don’t worry if some extra space is left at the
end of your new track; this can be taken care of during editing.
Helpful Links
For more information about recording Real Instrument tracks and some advanced tips, take a
look at Apple’s GarageBand Tutorial Lesson 2: Working with Real Instruments.
http://manuals.info.apple.com/en/GarageBand_TutorialPt2.pdf
For more information about Software Instruments, try Apple’s GarageBand Tutorial Lesson 3:
Working with Software Instruments.
http://manuals.info.apple.com/en/GarageBand_TutorialPt3.pdf
For helpful hints about using and configuring MIDI keyboards, take a look at MacJams.com’s
MIDI Basics for Apple GarageBand Users.
http://www.macjams.com/article.php?story=20040128064923856

II. Editing
A perfect take of a performance is hard to come by. GarageBand allows you to edit your tracks
so that you can fix the small mistakes that mar an otherwise great recording. No more
rerecording and hoping for perfection.
Found a loop that you like, but it needs some minor adjustments? You can also use the editing
tools to tailor a loop to your song.

GarageBand 2.0 – Recording, Editing, & Mixing

6

Editing Real Instruments
Real Instrument tracks are essentially audio recordings, so they do not have as much editing
potential as Software Instrument tracks. Real Instrument tracks can be cut, copied, and pasted,
but that’s about it.
Here, I’ve found a sound effect loop that I like, but it’s too long. I’ll edit the loop, cutting out a
portion at the beginning that I don’t want to use.
First, select the Real Instrument track you’d like to edit. Here is the sound effect loop that I want
to edit:

Now, I’ll click on the Track Editor button in the lower left corner of the window:
This will bring up the clip in the Track Editor in the bottom part of the GarageBand window.

If you’d like to see more (or fewer) measures in the editor screen at once, adjust the sliding bar in
the bottom left corner of the editor window. This will zoom in and out from the clip.
Now, I’ll select the portion of the loop that I want to edit. When I place the cursor in the blue area
of the editor, it will change to a dashed plus sign. Click and drag left and right to highlight an area
of the track. Now, click once on the selection, and it will become a new track. You can now
move, delete, copy, extend, repeat, or modify each piece of the track in any way you’d like. Here,
the first 8 beats of my loop are now a separate selection; I can delete them and move the last 2
measures to wherever I need them.

Editing Software Instruments
Software Instruments record every note of a performance individually, giving you more flexibility
when editing. You can edit each individual note’s pitch and length, along with cutting, copying,
and pasting.
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To begin, select the Software Instrument track you want to edit and click on the Track Editor
button. The Track Editor display will be much different from the display with the Real Instrument
track. Here, you have two display options: graphic view and notation view. The
two boxes in the lower left corner of the editor window allow you to choose which
view you’d like (see right).
Graphic view displays your track as a series of bars:

Each bar represents a note. The longer the bar, the longer the note lasts. The bar’s left/right
position tells where the note occurs within your track. The bar’s up/down position affects pitch.
Click on a bar to hear the note. You can click on each bar and drag it to a new place within the
track and/or to a new pitch (the note will play as you adjust the pitch). You can also adjust the
length of a bar. When you place the cursor at the right end of a bar, it will become the
resize cursor (see left). Drag the end of the bar to its desired length.
If you are familiar with musical notation, you may also want to edit your Software Instrument track
in notation view. This view displays the track on a staff in standard musical notation.

You can also drag a note to a new position in the track or up and down to a new pitch. Also,
when you click on a note, a green bar will appear to its right. This tells how long the note lasts,
just like in graphic view. To adjust this, just resize the bar.
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Remember: Notation view is NOT perfect! Programs specifically designed to transcribe and create
musical scores are available; GarageBand is not one of them!
For example, here is the section of Mozart’s Fantasie No. 3 in D minor that I recorded in the Software
Instrument track example above. Notice that the track editor does not register the same notation as
my original sheet music; even many of the note and rest lengths display differently.

You can also copy, cut, and paste Software Instrument tracks. In graphic or notation view,
highlight the desired area by clicking and dragging a box around the notes or bars. Now, in the
Edit menu, select Copy or Cut.
Note: When you cut a portion of a Software Instrument track, it will leave a silent gap for that
portion of the original track. Even if you cut the notes at the end of a track, silence will be left
behind.
You can paste a selection into an existing Software Instrument track by positioning the red
progress line where you would like the selection to be inserted. Click on Edit - Paste. If you
would rather paste your selection as a new track, click in the track line where you’d like it to go.
Now, click on Edit - Paste to insert the selection.
Importing Files
Have a song file or an audio CD track that you’d like to use in a GarageBand creation? Importing
audio files into GarageBand is quick and easy.
GarageBand allows you to import the following types of audio files: AIFF, WAV, AAC, Apple
Lossless Encoder, and MP3.
If you already have the file on the computer or a data CD, simply drag the file’s icon into a blank
area of the GarageBand window. A small green plus sign will appear beside the cursor when
you’re in the correct spot. Drop the file in the window, and GarageBand will import it as a new
track.
If your song is on an audio CD, you will first need to import the CD into iTunes. For information
on how to do this, see our iTunes 6.0 tutorial. Once the desired song appears in your iTunes
library, just drag the song from the iTunes window into the GarageBand window.
Imported files may be lengthy and difficult to process, so be patient; it may take GarageBand
awhile to fill in the imported track. Using imported files will also make the program run more
slowly.
Once you’ve imported a file, it will appear as an orange Real Instrument track.
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Now, you can edit and manipulate it as you would any other Real Instrument track.
Creating Your Own Loops
Did you record the perfect bass line or drum riff? Make it into a loop! Now, you’ll be able to use
that perfect rendition again and again, even in other songs.
First, select the track you’d like to use to create the loop. Open the Track Editor.
Highlight the area of the track that you’d like to become the loop. Copy your selection (Edit menu
– Copy) and paste it into the track window as a new track (be sure to move the progress triangle
so you don’t paste over your original recording!). Below, I’ve copied a section of my recorded
track (Live Classical Piano) and pasted it as a new track (which GarageBand has automatically
named Sequence).

If you want to make an entire track into a loop, don’t worry about cutting and pasting.
Now, select your desired track and, in the Edit menu, select Add to Loop Library. This will bring
up a box where you can describe the new loop.

Here, you can name the loop and describe its instrument, scale, genre, and mood. When
selecting Type (Loop or One-Shot), think about how you would like the loop to be used in the
future. If you’d the loop to change its tempo to match any song you use it with, select Loop.
One-Shot is best for arrhythmic loops that do not need to adjust to match different tempos (such
as sound effects) or for loops that will become distorted if they are not played at the original
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tempo. However, remember that One-Shot loops will be less versatile and harder to use in other
songs.
Click on Create to create your new loop. You can now find your loop in the Loop Editor for use in
this and other songs. Just like Apple’s pre-made loops, it can be repeated.

III. Mixing
Once you’ve edited and arranged your tracks to create a song, it’s time to add the finishing
touches. Adjusting the tracks’ effects and their volume helps the tracks to blend together and
takes your song from sounding raw to polished.
Track Controls
Each GarageBand track can be mixed separately using the controls available in the Track
column.

Below the track’s instrument are five buttons:

The record button will be red on the active recording track. If you were to start recording, this is
the track in which your recording would appear. Click on the button to change which track you
want to record.
Mute silences a track without changing its settings, including volume. At times, you may want to
listen to only a few tracks of your song more closely. To do this, mute the tracks you don’t want
to hear. Click the button again to unmute tracks.
Solo – If you’d like to listen to a single track by itself, click its Solo button. This will mute all of the
other tracks.
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(Un)lock secures a track so that it can’t be unintentionally changed. It also saves the track to
your hard drive, freeing up memory and allowing GarageBand to run faster. Click the button
again to be able to change the track again.
Volume/Pan allows you to vary the volume over the course of a track. The main volume slider on
the right side of the track information controls the volume for the track in entirety.
Track Effects
We already saw track effects briefly when creating a new Real or Software Instrument track, but
let’s take a closer look. I’ll be using a Real Instrument Track in these examples, but the process
is identical for Software Instrument Tracks.
First, open the track information for the track that you’d like to manipulate. To do this,
you can double-click on the main track box (with the instrument in it), or highlight the
track and click on the Track Info button in the lower-left corner of the window (see left).
This will bring up the window that appeared when we first created a track for recording. Click on
“Details” at the bottom of the window to display the effects options (if they do not already appear).
You can use GarageBand’s pre-made instruments to add effects to your tracks, or you can create
your own. In the window below, I’ve selected a pre-made bass, the Filter Bass. The lower half of
the window shows the effects that have been pre-selected for this instrument. You can tweak the
effects on a pre-made instrument to perfect the sound for your track.
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You can also tailor track effects to your liking without worrying about pre-made instruments.
When you first open the Track Information window, the effects will more than likely be unselected
or, perhaps, only use Echo and Reverb. Simply go through and select the effects and levels that
you’d like to use. Experiment with different sounds to get the perfect match for your song. In the
example below, I’ve selected my own effects rather than using a pre-made instrument.
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Hint: You can play your track while you’re in the Track Info window! So, you can adjust
your effects and playback your track without having to constantly re-open the Track Info
window. The track buttons, like mute and solo, also work while this window is open.
If you’d like to save your effects for use later, click on Save Instrument at the bottom of the
window.
For more advanced information about some of the audio effects available in GarageBand, take a
look at MacJams.com’s GarageBand Tutorial: Built-in Audio Unit Effects.
http://www.macjams.com/article.php?story=20040329063101758
Volume Manipulation
You’ve already seen how to change the volume of specific tracks. But, what if you want one
track’s volume to fluctuate at specific points in a song?
To do this, click on the Volume/Pan button in the track you’d like to edit. A line depicting the
track’s volume will appear below the usual instrument line in the track.
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The first time you open the Volume Pan area for a track, the line depicting volume will go straight
across the length of your song. This means that the track’s volume will remain at one level the
entire time.
In the example above, I wanted the volume of my Electronic Beats track to drop for a few
measures and then return to the beginning level. To do this, I added volume automation points;
these are the points where you want the track volume to change.
Click on the volume line to add an automation point. Now, adjust the point up and down to the
level you’d like (a display in decibels will appear next to your point as you move it). Most volume
effects will require more than one automation point. The example above required four points to
lower the volume for several measures and then raise it to the original level.

This example shows a simple fade effect. The volume is steady for two measures and then fades
over the course of about a measure and a half. I created two automation points for this effect:
one to designate when I wanted the fade to begin, and one to designate when and at what
volume I wanted it to end. Note: The point at the beginning of the track is automatically created.

IV. Exporting
Creating a song in GarageBand is useless if you can’t use it in other programs! Thankfully, it’s
easy to export your songs for use in other iLife programs and for burning to audio CDs.
Once your song is complete and ready for use, simply go to the File menu and select Export to
iTunes. GarageBand will process the song and immediately open iTunes. Your song will appear
in your library alongside your other audio tracks. Here, you can edit the title, artist, and other
information about the song.
To enter standard artist and album information about your exported songs, go to the GarageBand
menu and select Preferences. Click on the Export tab to enter this information.
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For more information about iTunes, see our iTunes 6.0 Tutorial.
Preventing Clipping
Before you export your song, you need to make sure that the volume is set at the proper level. If
the volume is too high, clipping (a snapping noise) may surface intermittently throughout the
song.
Clipping occurs for two main reasons: the volume of a Real Instrument track is too high while
recording, or the master volume of the song is too high. Every volume meter in GarageBand has
a “clipping meter”: the red indicator lights on the right end of the meter. If these light up, that track
or the overall song may encounter clipping when exported.

If you are experiencing clipping in your recorded Real Instrument tracks, lower the track volume in
the track information bar before you begin recording.

You may also need to lower your microphone’s input volume. This can be accomplished by
moving the microphone farther away from you or by adjusting the Input volume in the System
Preferences – Sound window (see Recording – External Instruments).
Check the volume slider in the lower right corner of the GarageBand window to see if your song
as a whole has a clipping problem. If so, you can lower the overall volume of the song. If this
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isn’t an option (perhaps certain tracks would be too quiet), you can lower the volume at specific
points in the song where distortion is occurring.
To do this, go to the Track menu and select Show Master Track. Now, a Master Volume line will
appear at the bottom of your song.

Add volume automation points to the line, just as we did with the volume pan example in the last
section. Now, you can adjust the volume at the points where it is clipping without having to
interfere with the sections that are not distorted.
For more information about clipping and how it can be prevented/resolved, look up the
“Preventing Clipping” topic in the GarageBand Help menu. Also available on Apple.com Support
at: http://docs.info.apple.com/article.html?artnum=165081.
iLife Suite Integration
The iLife Suite ’05 is composed of iMovieHD, iDVD, iPhoto, and GarageBand.

GarageBand works with these other programs via iTunes. Once you’ve exported your
GarageBand creation into iTunes, you will be able to incorporate it into your movies, slideshows,
and DVD menus. For specific information about using iTunes tracks in these programs, see our
tutorials for iPhoto, iMovieHD, and iDVD.
Recording Podcasts
GarageBand is the perfect program for recording your podcast. You can record spoken tracks
and incorporate music, sound effects, and other background effects to enhance your program.
To record the spoken portion of your podcast, setup a Real Instrument track in GarageBand and
connect a microphone to your computer. Be sure to adjust the input volume setting in System
Preferences – Sound. Now, just hit record and start talking! Don’t forget that track effects can
enhance spoken tracks too; give it a try. GarageBand includes several preset Vocals instruments
for Real Instrument tracks.

V. Helpful Links
Here are all of the links referenced throughout this tutorial, along with a few other handy
reference sites.
Apple’s GarageBand Tutorial Lesson 2: Working with Real Instruments

GarageBand 2.0 – Recording, Editing, & Mixing

17

In-depth information about recording, editing, and mixing Real Instrument tracks.
http://manuals.info.apple.com/en/GarageBand_TutorialPt2.pdf
Apple’s GarageBand Tutorial Lesson 3: Working with Software Instruments
In-depth information about recording, editing, and mixing Software Instrument tracks.
http://manuals.info.apple.com/en/GarageBand_TutorialPt3.pdf
Apple’s Hot Tips
Several suggestions on improving your GarageBand creations. (Even though this article has now
been renamed for GarageBand 3, all of the tips hold true for GarageBand 2.0 except for the
interface descriptions under “Create Your Own Software Instruments”).
http://www.apple.com/support/garageband/hottips/
Apple Support: Preventing Clipping
Preventing and resolving clipping problems in your GarageBand tracks and songs.
http://docs.info.apple.com/article.html?artnum=165081
Keyboard Shortcuts
GarageBand has many keyboard shortcuts, but remembering all of them is almost impossible!
Consult this handy reference guide.
http://www.apple.com/support/garageband/shortcuts/
MacJams.com – MIDI Basics for GarageBand
Information about connecting and configuring MIDI keyboards for use in GarageBand.
http://www.macjams.com/article.php?story=20040128064923856
MacJams.com – GarageBand Built-In Audio Unit Effects
Advanced tips on using several of the track effects available in GarageBand
http://www.macjams.com/article.php?story=20040329063101758
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